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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 

 

 
EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the European 
Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or 
use of any information contained in this document complies with all relevant export control regulations. ECN N /A. 

 

 
COPYRIGHT 

Copyright © 2021 Meggitt SA 

All rights reserved 

Published and printed by Meggitt SA in Fribourg, Switzerland 

The names of actual companies and products mentioned  
herein may be the trademarks of their respective owners. 

The information contained in this document is subject to change without notice.  
This information shall not be used, duplicated or disclosed, in whole or in part,  

without the express written permission of Meggitt SA. 
 
 
  

http://www.meggittsensing.com/energy


 

RELEASE NOTES 
VibroSight® 6.0.0 
4 / 67 

Document reference VIBROSIGHT-RN/E (660-010-013-231A) 
Version 31A – 04.03.2021 

 

PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 6.0.0 (CD part number 609-004-000-050). 

This document contains information about changes to the software since the previously released version 
(VibroSight 5.1.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), refer to the 
following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-221A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-228A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet 
        (document reference 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 
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• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E)  
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Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the software 

modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic,  Protect, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per 
year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix 
release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

• VM600 card(s) – to refer to VibroSight compatible cards that are installed in a VM600 rack (that is, the first 
generation of VM600 systems). 

The currently available VM600 cards that are designed for operation with the VibroSight software are the 
XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / 
XIO16T cards, unless otherwise stated. 

Where CPUx card is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless 
otherwise stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modulse that are installed in a VM600Mk2 rack (that 
is, the second generation of VM600 systems). 

The currently available VM600Mk2 cards that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module and 
the RLC16Mk2 relay module. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 
and VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 6.0.0 is a major level release and a new license key file is not required 
for updates and upgrades from VibroSight 5.1.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 7 Customer support. 

 

 

2 Features 

General 

2.1 Support for VM600Mk2 – the next generation of VM600 machinery protection system 

VibroSight 6.0.0 introduces full support for the second generation of VM600 rack-based machinery protection and 
condition monitoring sytems – known as VM600Mk2 – for machinery protection applications. 

 

VM600Mk2 hardware 

The Meggitt vibro-meter® VM600Mk2 rack-based monitoring system is the evolution of the original VM600 
(VM600Mk1) solution for the protection and monitoring of rotating machinery used in the power generation and oil & 
gas industries. VM600Mk2 solutions are recommended when a centralised monitoring system with a medium to 
large number of measurement points (channels) is required. VM600Mk2 is typically used for the monitoring and/or 
protection of larger machinery such as gas, steam and hydro turbines, and generators, smaller machines such as 
compressors, fans, motors, pumps and propellers, as well as balance-of- plant (BOP) equipment. 

VM600Mk2 systems use existing VM600 rack infrastructure (racks and power supplies) with a new set of VM600Mk2 
modules: 

• VM600Mk2  MPC4Mk2 + IOC4Mk2  machinery protection and condition monitoring module 

• VM600Mk2  RLC16Mk2  relay module 

 

These new VM600Mk2 modules use the latest technology to offer improved performance compared to the existing 
MPC4 / IOC4T machinery protection card pair and RLC16 card. 

For example, the VM600Mk2  MPC4Mk2 + IOC4Mk2  has 24 bit ADC resolution, 20 kHz bandwidth, up to 5 
measurement outputs per channel, uses epoxy sealed relays and incorporates a physical card lock for 
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cybersecurity. (For reference, the VM600Mk1  MPC4 / IOC4T has 12 bit ADC resolution, 10 kHz bandwidth, up to 2 
measurement outputs per channel, does not use epoxy sealed relays and does not incorporate a physical card lock 
for cybersecurity.) 

 

NOTE: Earlier development and evaluation versions of VM600Mk2 systems were referred to 
as VM600 MPSG2, earlier versions of the MPC4Mk2 + IOC4Mk2 machinery 
protection and condition monitoring module were referred to as the MPC4G2 and 
IOC4G2 card pair, and earlier versions of the RLC16Mk2 relay card were referred to 
as the RLC16G2 card. However, Mk2 is now the official terminology. 

 

 

VM600Mk2 software 

The VibroSight software includes significant updates to all of its software modules (VibroSight Server and 
VibroSight client application modules (System Manager, Vision, etc.)) in order to support the new VM600Mk2 
modules/system. 

Significantly, VibroSight 6.0.0 now includes VibroSight Protect, a new VibroSight client application dedicated to the 
configuration and operation of VM600Mk2 systems, that is, MPC4Mk2 + IOC4Mk2 modules and RLC16Mk2 modules for 
machinery protection applications. 

NOTE: VibroSight Protect is distinct and separate from VibroSight Configurator in order to 
ensure the segregation of VM600Mk2 machinery protection systems (MPSs) and 
other systems such as condition monitoring systems (CMSs) when both are 
installed in the same VM600 rack (for example, as required by API 670). 

In this way, MPS and CMS configurations use separate tools with separate 
configuration files. So it is simply not possible for access and/or changes to a CMS 
(VibroSight Configurator) to interfere in the operation of a MPS (VibroSight Protect) 
in the same VM600 rack, whether by accident or intent. 

(For reference, VM600Mk1 machinery protection systems (MPSs) are configurated 
and operated using the VM600 MPSx software.) 

 

The other existing VibroSight software modules are used for the operation and management of VM600Mk2 cards in 
the usual manner. For example, VibroSight Vision is used to display measurements from MPC4Mk2 + IOC4Mk2 
modules, while VibroSight System Manager is used to update firmware, download log files, and so on. 

 

VibroSight Protect and VM600Mk2 systems 

VibroSight Protect is the new VibroSight software module, featuring a modern and ultra-clear user-interface, 
designed for the configuration and operation of VM600Mk2 systems for machinery protection. 
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VibroSight Protect allows for the configuration of complete VM600Mk2 systems, consisting of: 

• VM600Mk2 racks – 6U (ABE04x system racks) and 1U (ABE056 slimline racks) 

• VM600Mk2 MPC4Mk2 + IOC4Mk2 modules 

• RLC16Mk2 modules. 

 

With VibroSight Protect, the signal list (Excel file) typically required by a VM600Mk1 system is no longer needed. A 
VM600Mk2 system configuration can now be created directly by an end-user and then used by Meggitt to build the 
system (as a VibroSight Protect configuration file contains all of the required information). 

NOTE: VibroSight Protect is completely separate and distinct to VibroSight Capture and 
VibroSight Configurator in order to ensure the complete separation (“segregation”) 
of machinery protection and condition monitoring in a VM600 rack. 

 

VibroSight Protect user interface – Welcome screen 

When VibroSight Protect starts, the Welcome screen displays a view that allows the user to create a new 
VM600Mk2 system configuration (New system), open an existing VM600Mk2 system configuration file (Open Protect 
file) or connect to VM600Mk2 system hardware (Connect to system). This is shown in Figure 1. 

 

 
Figure 1: VibroSight Capture Welcome screen 
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Alternatively, the File menu command can be used to perform the same functions (New, Open, Connect). 

For example, to start working on a new VM600Mk2 system configuration using a VM600 system rack (ABE04x), click 
the VM600 - 6U icon. 

 
 
When working on a VM600Mk2 system (new or existing), the VibroSight Protect user interface consists of three main 
tabs/pages: Layout, Configure and Dashboard. 

 

 

VibroSight Protect user interface – Layout tab/page 

The Layout tab/page is used for the configuration and display of general information for the VM600 rack / VM600Mk2 
system. This is shown in Figure 2. 

 

 
Figure 2: VibroSight Protect Layout tab/page 

 

System properties (left) is used to define information about the rack, including the specific type of rack. 

System I/O (left) provides summary information on the inputs, outputs and resources used by the rack. This is 
dynamically updated as modules are added to the rack and configured. 

Power consumption calculator (left) is used to define information about the power supply configuration used by the 
rack. This is dynamically updated as modules are added to the rack and configured, so that the user knows if the 
power supply configuration is suitable for the populated rack. 
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Main window (centre) is used to add modules to the rack. Double-clicking a blank (empty) rack position/slot allows 
a new module to be selected for that position/slot. 

For example: 

MPC4Mk2 modules can be added in position/slot 3 to 14 (front of rack). When a MPC4Mk2 module is added, the 
associated IOC4Mk2 module is automatically added in the corresponding position/slot in the rear of the rack. 

RLC16Mk2 modules can be added in position/slot 1 to 14 (rear of rack). 

In the main window, the Rotate control (top right) is used to toggle the view of the rack between the front view or 
the rear view. 

In the main window, the Bus view control (top right) is used to toggle the view between the rack view or the rack 
buses view. The Bus view is shown in Figure 3. 

 

 
Figure 3: VibroSight Protect Layout tab/page – Bus view 

 

In the Bus view, the rack buses are shown as grey if unused or shown as blue if used. If a bus is used, then 
jumpers on the IOC4Mk2 and/or RLC16Mk2 are must be manually configured. Jumper configuration is available from 
the Configure tab/page by selecting each module and then its Jumpers tab. 

To display more detailed information on the configuration and usage of individual VM600 rack buses, click one of 
the bus names (left of rack) on the Bus view in order to display an individual bus window: 

• Raw bus 
64 lines 
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• Tacho bus 
6 lines 

• OC Bus F 
16 lines 
to 
OC Bus A 
16 lines 

The individual bus windows for the Tacho bus, Raw bus and OC Bus n display detailed information on the 
configuration and usage of the individual VM600 rack bus. Initially, they show the default bus configuration as 
determined by VibroSight Protect for the application. They also allow the automatically assigned bus configuration 
to be changed, should this becomenecessary. 

 

System (right) is used to remove modules from the rack. 

History (right) is used to undo or redo recent changes to the rack using the “–” icon (Remove item). 

 

Consistency check (bottom) is used to run and/or display consistency check information so that any problems in the 
VM600Mk2 system configuration can be corrected. The Consistency check title bar is displayed in purple if no 
problems ae detected but is displayed in red if problems are detected. 

Clicking on the Consistency check title bar expands or collapses the consistency check window, as required. 
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VibroSight Protect user interface – Configure tab/page 

The Configure tab/page is used for the configuration and display of general information for the modules in the 
VM600 rack / VM600Mk2 system, that is, the VM600Mk2 MPC4Mk2 + IOC4Mk2 and RLC16Mk2. This is shown in Figure 
2. 

 

  
Figure 4: VibroSight Configure Layout tab/page 

 

Main window (top) shows the bottom portion of the rack configured in the Layout tab/page.  

As in the Layout tab/page, the Rotate control (top right) is used to toggle the view of the rack between the front 
view or the rear view. 

 

When a VM600Mk2 module is selected in the rack (top) by clicking on it, the main features for the module are 
displayed in functional groups in the main window (left) and general information for the module is displayed in the 
main window (centre). 

For a VM600Mk2 MPC4Mk2 + IOC4Mk2 module, the main features are Channels, Logical functions, Relays and 
Analog outputs. And the general information includes module Enable, Name and Description, Network settings 
(IP address) and the Watch RLC16 relay status control on the General tab and the required jumper configuration 
on the Jumpers tab. 
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For a VM600Mk2 RLC16Mk2 module, the main features are Logical functions and Relays. And the general 
information includes module Enable, Name and Description on the General tab and the required jumper 
configuration on the Jumpers tab. 

When an item is selected from a functional group in the main window (left), the main window (centre) updates to 
display the information for the item, including all configurable parameters. 

 

For VM600Mk2 MPC4Mk2 + IOC4Mk2 modules 

When a Channel is selected for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module by clicking on it (in a functional group, left) 
and the channel is not yet configured, a Configuration of a Channel window is displayed that guides the user 
through the configuration of the channel in terms of: 

• Processing type: single-channel or dual-channel. 

• Processing function (based on sensor family): For example, bearing absolute vibration or shaft relative 
vibration. 

• Input signal: From a library of sensors / measurement chains. 
Note: The default Library can be expanded by editing sensors / measurement chains and/or adding new ones 
(vibro-meter® or third-party), as required. 

• When a Channel is selected for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module by clicking on it and the channel is 
already configured, the information for the channel is displayed in a series of tabs (General, Processing, 
Alarms). 

Once the Channel is configured, the information for the channel is displayed in a series of tabs (General, 
Processing, Alarms). 

Similarly, when a Channel is selected for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module by clicking on it (in a functional 
group, left) and the channel is already configured, the information for the channel is displayed in a series of tabs 
(General, Processing, Alarms). 

For each Channel, the General, Processing and Alarms tabs must be edited in the main window (centre) to 
configure the parameters and functionality for the channel, as required by the application. 

When a Logical function, Relay or Analog output is selected for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module by clicking 
on it (in a functional group, left), the information and parameters for the feature are displayed in the main window 
(centre), where they must be edited, as required by the application. 

 

For RLC16Mk2 modules 

When a Logical function or Relay is selected for a VM600Mk2 RLC16Mk2 module by clicking on it (in a functional 
group, left), the information and parameters for the feature are displayed in the main window (centre), where they 
must be edited, as required by the application. 

 

As in the Layout tab/page, System (right) is used to remove modules from the rack, History (right) is used to undo 
or redo recent changes to the rack using the “–” icon (Remove item) and Consistency check (bottom) is used to run 
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and/or display consistency check information so that any problems in the VM600Mk2 system configuration can be 
corrected. 

 

 

VibroSight Protect user interface – Dashboard tab/page 

The Dashboard tab/page is used to upload a VM600Mk2 system configuration to a VM600 rack and/or operate the 
VM600Mk2 system. This is shown in Figure 5. 

  
Figure 5: VibroSight Dashboard Layout tab/page 

 

When a VM600Mk2 system configuration is uploaded to a VM600 rack: 

• All of the modules contained in the configuration must be available at the same time. More specifically, all 
MPC4Mk2 modules must be connected to and available on the same network as the computer running 
VibroSight Protect. (This is typically done using a network switch.) 

• When a configuration is uploaded to a VM600 rack, a MPC4Mk2 module will restart after receiving the 
configuration in order to enter their Power-up mode and perform a power-on self-test (POST), thereby helping 
to ensure that the configuration is correct and valid. 
Note: A MPC4Mk2 module takes approximately 20 seconds to boot and complete its power-on self-test (POST). 
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• After successfully booting, a MPC4Mk2 module will revert to its Operational mode – in either the Locked state 
(safety/secure operating mode) or Unocked state (maintenance operating mode), depending on the 
Operational mode state it was in before rebooting. 
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VibroSight System Manager and VM600Mk2 systems 

For VM600Mk2 systems, VibroSight System Manger is used to display information about VM600Mk2 MPC4Mk2 + 
IOC4Mk2 modules. 

As shown in shown in Figure 6 (centre), under General Information, this includes the Operating mode, which for a 
MPC4Mk2 modules can be one of 4 modes: 

• Power-up 

• Operational 

• Fail-safe 

• Recovery. 

 

Further, the Operational mode can be in one of 2 states: 

• Locked (safety/secure operating mode) 
The VM600Mk2 system performs its monitoring and protection functions while ensuring the security of the 
modules/system and it’s configuration. That is, the configuration cannot be changed and maintenance activities 
cannot be performed. 

• Unlocked (maintenance operating mode) 
The VM600Mk2 system performs its monitoring and protection functions without ensuring the security of the 
modules/system and it’s configuration. That is, the configuration can be changed and maintenance activities 
can be performed. 

NOTE: Physical access to a VM600Mk2 system (specifically, the buttons on the front panel 
of VM600Mk2 module) is required in order to change the operating mode and 
therefore to be able to change the machinery protection (MPS) functionality for a 
VM600Mk2 system. 

 

The Lock state is shown under Diagnostics (see Figure 6), as are the firmware versions available on the module 
(under Firmware versions). 
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Figure 6: VibroSight System Manager information and actions for a MPC4Mk2 module 

 

Figure 6 (right) also shows the various actions/tasks that VibroSight System Manger can perform for MPC4Mk2 
modules, notably: 

• Maintenance: Changing firmware, LED test and module identification. 

• Configuration: Configuration of IP and NTP settings. 

• Diagnostics: Download of diagnostics log. 
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VM600Mk2 MPC4Mk2 + IOC4Mk2 module factory assigned defaults 

Unless already configured as part of a VM600Mk2 solution, VM600Mk2 MPC4Mk2 + IOC4Mk2 modules are supplied with 
the following factory assigned defaults: 

• Communications: LAN (Ethernet) port configured as Enabled using dynamic addressing (DHCP). 

• Firmware: Loaded with latest version of Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) only. 

Accordingly, the LAN (Ethernet) port must be configured to meet your communication requirements and the latest 
version of the Operational firmware (640-025-vvv-ppp.Mpc4g2Fw) must be uploaded. 

Both of these tasks are performed using VibroSight System Manger and are explained in the VM600Mk2 machinery 
protection system (MPS) quick start manual. 

 

 

 

2.2 VibroSight Server support for Modbus RTU communications 

VibroSight 6.0.0 adds improved support for Modbus RTU (serial) communications so that a VibroSight Server can 
now also act as a Modbus server (slave) in order to more easily share data from the VibroSight system with third-
party systems such as a DCS or PLC. 

(Previously, VibroSight support for Modbus RTU (serial) allowed a VibroSight Server to act as Modbus client 
(master) only, in order to easily import data into the VibroSight system from third-party systems.) 

 

VibroSight’s implemenation of Modbus RTU (serial interface): 

• Supports the import and export of static data only, for example, extracted data entities. 
• Is configurable for Modbus communication parameters such as baud rate (up to 38400), character format, 

device addresses (unit IDs), etc. 

• Has a default data update rate of 1 second. 
 

 

To configure a VibroSight Server to use a Modbus RTU server (slave) 

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration (File > New > VibroSight Server configuration) or open and 
modify an existing one (File > Open > … (*.vscfg)). 

2. In the Hardware view (right), right-click the VibroSight Server Configuration (the root node in the hierarchical 
tree structure), then click New Serial Modbus Device. 
A new Serial Modbus Device node is added under the VibroSight Server Configuration in the hierarchical tree 
(Hardware view) and the parameters window (centre) updates to display the parameters for the Serial Modbus 
Device. 

3. In the parameters window (centre), change the Mode control to Modbus Slave to configure the Serial Modbus 
Device for operation as a Modbus server (slave). 
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Note: 
• Mode: Modbus Master (the default) configures the Serial Modbus Device for operation as a Modbus client 
(master), which allows VibroSight to act as Modus master device and request data from Modbus server (slave) 
devices (that is, data import). 
• Mode: Modbus Slave configures the Serial Modbus Device for operation as a Modbus server (slave), which 
allows VibroSight to act as Modus slave device and respond to requests for data from Modbus client (master) 
devices (that is, data export). 
 
Configure the remainder of the Modbus communication parameters for the Serial Modbus Device as usual. 
Note: 
• When configuring a Serial Modbus Device as a Modus client (Mode: Modbus Master), the Unit ID is the 
address of the remote Modbus server (slave) device that VibroSight requests data from. 
• When configuring a Serial Modbus Device as a Modus server (Mode: Modbus Slave), the Unit ID is the 
address of the VibroSight Modbus server (slave) device itself. 

4. In the Hardware view (right), right-click the Serial Modbus Device, then click New Processing Block to add 
and configure a Processing Block for the Serial Modbus Device, notably the data update rate. 
Note: 
• When configuring a Serial Modbus Device as a Modus server (Mode: Modbus Slave), the Request data 
in block control is not used as it is not applicable to a Modbus server (slave). 

5. In the Hardware view (right), right-click the Processing Block node, then click New Data Entity to add and 
configure a Data Entity for the Serial Modbus Device, including the Modbus data mapping 

6. Save the configuration file, generate a Server / Database and activate the configuration on the VibroSight 
Server in the usual way. 

 

Once the VibroSight Server is generated and activated in the usual way, it is ready and available to provide data 
via Modbus RTU. 

 

 

2.3 Export and import of configurations for a VibroSight OPC UA client 

VibroSight 6.0.0 adds improved support for OPC UA client configuration in order to make it easier to configure a 
VibroSight Server with an OPC UA Device to act as an OPC client in order to more easily import data into a 
VibroSight system from third-party systems such as a DCS or PLC. 

(Previously, VibroSight support for OPC UA client configuration required that each data entity (OPC tag) was 
configured manually, although OPC clients (OPC Devices) did support the Import from CSV and Export to CSV.) 

 

 



 

RELEASE NOTES 
VibroSight® 6.0.0 
24 / 67 

Document reference VIBROSIGHT-RN/E (660-010-013-231A) 
Version 31A – 04.03.2021 

 

VibroSight OPC UA clients (OPC UA Devices) now support the use of comma-separated values (CSV) files to 
share OPC UA configuration information (in the same way that OPC  clients (OPC  Devices) already do: 

• A VibroSight OPC UA client can export an OPC UA configuration that was entered in VibroSight Configurator 
in order to more easily share it with another system. 

• A VibroSight OPC UA client can import an OPC UA configuration that was generated in a different VibroSight 
configuration or a third party system in order to avoid manually re-entering the configuration in VibroSight 
Configurator. 

This new feature helps avoid the errors in manually entering OPC UA configuration information and also saves 
considerable time for systems using large OPC UA configurations. 

 

To export OPC UA configuration information 

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration (File > New > VibroSight Server configuration) or open and 
modify an existing one (File > Open > … (*.vscfg)). 

2. In the Hardware view (right), right-click the VibroSight Server Configuration (the root node in the hierarchical 
tree structure), then click New OPC UA Device. 
A new OPC UA Device node is added under the VibroSight Server Configuration in the hierarchical tree 
(Hardware view) and the parameters window (centre) updates to display the parameters for the 
OPC UA Device. 

3. In the parameters window (centre), configure the OPC UA Device for operation as usual, notably the 
OPC UA Server and the security and authentication settings. 

4. In the Hardware view (right), right-click the OPC UA Device, then click New Processing Block to add and 
configure a Processing Block for the OPC UA Device, notably the publishing interval (data update rate). 

5. In the Hardware view (right), right-click the Processing Block node, then click New Scalar Data Entity to add 
and configure a Scalar Data Entity for the OPC UA Device. 
Note: 
Under OPC UA Node (“tag”), the Browse button can be used to select the OPC data item from the list 
published by the UPC UA Server (configured at the OPC UA Device node level). 

6. Once the Processing Blocks and Scalar Data Entities have been configured as required, in the Hardware view 
(right) at either an OPC UA Device or Processing Block node level, right-click, then click Export to CSV. 

7. Use the Export to CSV dialog box that appears to navigate the folders on the computer and select in which 
folder and under what file name to save the OPC UA configuration. 
The OPC UA configuration is exported and a message is displayed with a count of the number of processing 
blocks and data entities exported 
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To import OPC UA configuration information 

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration (File > New > VibroSight Server configuration) or open and 
modify an existing one (File > Open > … (*.vscfg)). 

2. In the Hardware view (right), right-click the VibroSight Server Configuration (the root node in the hierarchical 
tree structure), then click New OPC UA Device. 
A new OPC UA Device node is added under the VibroSight Server Configuration in the hierarchical tree 
(Hardware view) and the parameters window (centre) updates to display the parameters for the 
OPC UA Device. 

3. In the parameters window (centre), configure the OPC UA Device for operation as usual, notably the 
OPC UA Server and the security and authentication settings. 

8. In the Hardware view (right), at either an OPC UA Device or Processing Block node level, right-click, then click 
Import from CSV. 

9. Use the Import from CSV dialog box that appears to navigate the folders on the computer and select the file 
containing the OPC UA configuration and click Open to continue. 

10. Use the Import from CSV wizard that appears to select the appropriate Delimiter and File encoding, as used by 
the CSV file and click Next to continue. 
Note: Delimiter: Comma and File origin: 1252: Western European (Windows) are suitable for most CSV files, 
including those exported by VibroSight Configurator. 

11. The Import from CSV wizard will parse the CSV file. 
For a valid CSV file, the OPC UA configuration is imported. 
For an invalid CSV file, for example, with missing mandatory values or invalid values, appropriate messages 
are displayed to the user. 

12. After importation, the OPC UA configuration is available in the Hardware view of VibroSight Configurator as 
Processing Blocks and Scalar Data Entities. 

 

The configurable parameters for a Modbus measurement that are exported/imported by VibroSight Modbus clients 
include: 

• At the Processing Block level: name, state, publishing interval (update rate). 

• At the Scalar Data Entity level: name, state, OPC UA node (“tag”), physical quantity, unit, qualifier, 
scale factor, FDR min unit, FDR min value, FDR max unit, FDR max value, alarm state, 
alarm event generation state, alarm unit, alarm severities, alarm limits. 

 

Application tips and tricks 

Before using a CSV file to import OPC UA configuration information for the first time, it is a good idea to generate a 
simple “dummy” OPC UA Device configuration and export it to CSV. The exported CSV file is a useful 
template/reference CSV file that can be used to help structure information from third-party OPC systems into the 
CSV file format used by VibroSight Configurator. 
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2.4 VibroSight Vision performance configuration 

VibroSight 6.0.0 adds the ability to configure performance limits in VibroSight Vision so that the behaviour of 
VibroSight Vision can be optimised, depending on the capabilities of computer system that the software is running 
on and the user requirements. 

 

To configure VibroSight Vision performance limits 

In VibroSight Vision: 

1. Click Tools > Options to display the configurable options for VibroSight Vision. 

2. In the Options window, click Performance (left) to display the performance limits information. 

3. Under General (right), use the slider control to select a computer system that matches the type of computer 
that the VibroSight software is running on: 
• Standard corresponds to a typical general-purpose computer as used for standard machinery monitoring 
applications. 
• High corresponds to a typical high-performance computer as used by demanding machinery monitoring 
applications. For example, a computer with a powerful processor (64-bit (x64) CPU), lots of system memory 
(RAM) and a dedicated/separate graphics card. 
• Unlimted corresponds to a really high-performance computer. 

4. Under Dynamic data plots (right), enter the maximum total number of items (curves) that should be displayed 
in any one dynamic data plot (such as waveforms, spectra or orbits). 

5. Click OK to confirm any changes and continue. 

 

Note: By default, VibroSight Vision defaults to a Standard computer with and 250 curves (max.) in a plot. 

 

 

2.5 Mathematical post-processing support for vector data 

VibroSight 6.0.0 adds improved support for vector data in VibroSight software’s ‘Mathematical outputs’ application 
specific package. In a VibroSight Server’s Math Processing Block, when a vector data entity is now used in a 
mathematical expression, both the amplitude/magnitude information (value) and the angle information (angle value) 
are available. 

(Previously, VibroSight’s Mathematical outputs package support for vector data allowed vectors to be used, 
however only the amplitude/magnitude information (value) was available as the angle information (angle value) 
was discarded.) 

 



 

Document reference VIBROSIGHT-RN/E (660-010-013-231A) 
Version 31A – 04.03.2021 

RELEASE NOTES 
VibroSight® 6.0.0 

27 / 67 
 

More specifically, the amplitude/magnitude (value) and angle (angle value) for a vector data entity is now available 
as complex number for use in mathematical expressions. 

To do this, the vector data entity (amplitude, angle) is converted into a complex number (real part, imaginary part) 
as follows: 

real part =  amplitude  ×  cosine (angle) 

imaginary part  =  amplitude  ×  sine (angle) 

 

This effectively allows vector mathematical operations to be performed and tested (using the value and angle value 
inputs in the Input test values of the Test window) in VibroSight’s Mathematical outputs package. 

 

Application tips and tricks 

Vector mathematical operations in VibroSight’s Mathematical outputs package means that VibroSight can now be 
more easily used for the online balancing of steam turbines, amongst other operations. 

 

 

 

VM600 cards 

2.6 MPC4Mk2 + IOC4Mk2 – product launch firmware 

To support the launch of the new VibroSight / VM600Mk2 systems, new officially released versions of firmware for 
the MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module are now available. 

 

NOTE: VibroSight / VM600Mk2 is now officially released. 
Current “evaluation” versions of VibroSight / VM600Mk2 systems must be upgraded 
to the latest officially released VM600Mk2 MPC4Mk2 firmware – in order to use the 
system in “live” machinery protection system (MPS) applications. 
Contact Meggitt SA for further information. 

 

See 2.1 Support for VM600Mk2 – the next generation of VM600 machinery protection system, and 
5.2.1 Card firmware. 
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 6.0.0 software. 

 

3.2 Problems creating a VibroSight Server for VibroSmart VSI010 modules using the GOOSE 
communications interface 

In VibroSight Configurator, when working with VibroSight Server configurations containing a VibroSmart VSI010 
communications interface module using a GOOSE communications interface (IEC 61850 GOOSE protocol), 
problems could be experienced when saving the configuration as a server / database. For example, problems 
saving the configuration or problems establishing communications with the VibroSight Server. 

 

3.3 Problems manually copying a VibroSight database 

In VibroSight System Manger, when manually copying a VibroSight database using the Data repositories Copy 
command, problems could be experienced when only a few selected data items are required to be copied because 
the VibroSight Server incorrectly used default copy options that included all data. 

 

3.4 Problems manually copying a VibroSight database 

In VibroSight Configurator, working with VibroSight Server configurations containing an OPC UA Device (that is, an 
OPC client), when using the OPC UA Node browser at the Scalar data entity node level to select the OPC data 
item to use for the data entity, the OK button could be disabled, thereby preventing certain data items from being 
selected. (This happened if the TypeDefinition was different to the AnalogItemType, even though VibroSight is 
compatible with such data items.) 

 

3.5 Problems saving diagnostic information in VibroSight Vision 

In VibroSight Vision, when trying to save diagnostic information (Help > Save diagnostic information), the 
diagnostic information file could not be saved, depending on the other VibroSight application software modules 
open and running on the same computer. 

 

3.6 Time slider controls not displayed in plots on some computers 

When displaying plots such as Waveform plots that include time slider controls in VibroSight Vision, the time slider 
controls were not being displayed on some computers. This issue was reported mostly for Windows 10 computers. 

The issue has been traced to the computer’s display settings in general and display scaling settings in particular 
that are too low. On all of the Windows 10 computers tested, a display scaling setting/size of 125% or higher 
eliminated the problem. 

For example: Windows 10 > Display settings > Scale and layout – Scaling 125%. 
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3.7 NTP timeouts between a VibroSight Server and a VibroSmart module 

Under certain circumstances, a VibroSight Server could not obtain the requested NTP time from VibroSmart a 
module, with the VibroSight Server displaying a message such as “Unable to retrieve the current date for device 
'192.168.0.5': it does not respond.” and spammed log files. 

 

3.8 OPC UA exception when two VibroSight Servers using OPC UA servers running on 
one computer 

When attempting to run two VibroSight Servers using OPC UA servers on one computer, only one of the VibroSight 
Servers would run, with the VibroSight Server displaying a message such as “Unable to start OPC UA Server. 
Unexpected exception prevented the start the OPC UA Server.” 

 

3.9 Problems with spectra polarity in Full Spectrum plots 

When displaying Full Spectrum plots in VibroSight Vision, spectra amplitudes were displayed correctly but the sign 
of the spectra amplitudes could be displayed incorrectly for certain configurations. More specifically, depending on 
the relative sensor orientations and the shaft’s sense of rotation, the order of the dual shaft relative processing 
could be incorrect, resulting in incorrect spectra polarity. 

Note: A workaround was previously available for this bug that involved changing the order of the probes/channels 
in the dual shaft relative processing block such that the first channel seen by the system (that is, the first “pass by” 
depending on sensor orientation and shaft rotation) was first in the processing block (that is, X Channel Setup 
(on left)). 

 

3.10 VibroSight Server memory leak 

Depending on the configuration, a VibroSight Server could exhibit a memory leak such that the server memory 
usage gradually increased, affecting performance, until all system memory (RAM) was used. 

 

3.11 Slow generation of rotor signatures for Hydro air-gap monitoring package using VibroSmart 
VSV30x modules 

In VibroSight Vision, the generation and display of rotor signatures by the Hydro air-gap monitoring package was 
slow when VibroSmart VSV30x modules were used (approx. 2 minutes). 
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3.12 Problems with time-based data logging rule 

Depending on the configuration: 

• Time-based data logging rules without a condition could log dynamic data (such as waveforms, spectra or 
orbits) for a time period before data logging was enabled using the Data logging manager control in the 
VibroSight Server. 

• Time-based data logging rules with a condition – for systems using VibroSmart modules – could log static data 
correctly but dynamic data (such as waveforms, spectra or orbits) incorrectly, omitting the first two dynamic 
data items when the condition becomes true and adding two extra dynamic data items after the condition 
becomes false. 

• Time-based data logging rules with a condition and pre-logging enabled could log static data at a logging rate 
of 100 ms during the pre-logging time period and when the condition initially becomes true (for a few seconds), 
even though the logging rate for the rule was configured as 1 second. 

 

3.13 Problem with alarm-event-based data logging rule 

Depending on the configuration, alarm-event-based data logging rules with pre-logging and/or post-logging enabled 
at a logging rate of 100 ms and Data entities that included waveforms, orbits, spectra and/or full spectra, could log 
data incorrectly with the VibroSight Server displaying messages such as “Card … did not send all required 
waveforms / spectra”. For example, waveforms could be missing data points for the post-logging time period, no 
spectra could be available for the pre-logging time period and/or full spectra could be available reduced data rates 
of 1 or 10 second for the pre-logging time period. 

 

3.14 OPC UA Server publishing data values with different qualifiers 

For VibroSight measurements (data entities) made with certain qualifiers (rectifiers), a VibroSight OPC UA Server 
actually publishes the data values using a different qualifier. So while the published data value is correct for the 
qualifier used, the qualifier used is not the one expected. 

For example, measurements configured as True Peak-Peak (t_pp) were exported as Scaled True Peak-Peak 
(st_pp), and measurements configured as Scaled Average (t_avg) were exported as True RMS (t_RMS). 

This has been fixed so that the qualifier configured for the measurement (data entities) is the qualifier used for data 
export. Please note that in addition to correcting the VibroSight OPC UA Server, the same fix was similarly applied 
to the VibroSight OPC Classic and Modbus servers. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

 

4.2 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 
 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 
 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 

 
 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 
 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 
 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 
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Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 
 

4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 
This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 
 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 
 

4.11 Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 
Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 
displaying an error message such as 
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC Classic 
Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

• When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 
OpcServer.config file. 
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• When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 
incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 
experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 
information. That is, change the line containing the section name 
from: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 
    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 
    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Classic Servers to 
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 
guide. 
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4.12 Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully installed and run. 

 

 

4.13 Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 

This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 

 

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
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NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

 

4.14 Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 
message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 
certification authority that is not installed on the computer, and the computer cannot automatically download the 
required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  
Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 
certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 

 

If required, additional information is available from a Microsoft MSDN blog, here: 
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-
authority-2 

  

https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually installed 
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 5.1.4) software is automatically installed on 
the computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 5.1.5) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

 

5.1 VibroSight software 

VibroSight 6.0.0 is a major level release and replaces VibroSight 5.1.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 
the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a VibroSight 
Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 6.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 
they can be used with VibroSight 6.x.x (VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 6.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 6.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 6.x.x (VibroSight 3.x.x or later) or later is described in detail in the 
“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 
 
5.1.1 Microsoft Windows operating systems 
VibroSight 6.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 

 

 

5.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 6.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 
Framework 4.7.2 or later is installed. 

NOTE: VibroSight 6.x.x requires Microsoft .NET Framework 4.7.2. 

 
If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 
Framework requirements. 
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5.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 6.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 6.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 6.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 
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5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 6.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) 
for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with 
historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 
VibroSight software. 

NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 
historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 
databases and introduced initial support for working with data repositories based 
on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 
SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 6.x.x (VibroSight 3.x.x or later) is described in detail in the “Data 

migration” section of the latest  Getting started with VibroSight installation 
guide. 

 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600 cards 

5.2.1 Card firmware 

There are some firmware upgrades for VM600 cards corresponding to VibroSight 6.0.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 card is now: 

• Operational: 640-025-003-002.Mpc4g2Fw. 

• Recovery: 640-031-003-002.Mpc4g2Fw. 

• Proof test: 640-032-001-000.VxeFw. 

See 2.6 MPC4Mk2 + IOC4Mk2 – product launch firmware. 

 

The latest firmware for the VM600 CPUR2 card remains: 

• Base System: base-system-640-014-001-003.tgz 

• Applications: applications-640-015-001-003.tgz. 

 

The latest firmware for the VM600 CPUR card remains: 

• Base System: base-system-640-011-001-005.tgz 

• Applications: applications-640-012-001-005.tgz. 

 

NOTE: In order to help distinguish between VM600 CPUx cards, VibroSight 6.0.0 or later 
uses the following terminology: 
• CPUMk2 to refer to the latest VM600Mk2 version of the CPUx card with support for 
mathematical processing of fieldbus data and support for Modbus TCP and 
PROFIBUS DP (PNR 600-026-000-VVV). 
• CPUR2 to refer to the latest version of the CPUx card with support for 
PROFIBUS (PNR 600-026-000-VVV). 
• CPUR to refer to the earlier version of the CPUx card with support for 
Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-VVV). 

(Previously, VibroSight 2.12.7 to 3.8.x used CPUR to refer to the CPUx card with 
PROFIBUS but VibroSight 4.x.x or later refers to this card as the CPUR2.) 
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The latest firmware for the VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Base System: base-system-640-003-001-016.tgz 

• Applications: applications-640-010-001-016.tgz. 

 

Therefore, for current “evaluation” versions of VibroSight / VM600Mk2 systems, firmware upgrades are required now 
that .VibroSight / VM600Mk2 is officially released – in order to use the system in “live” machinery protection system 
(MPS) applications. 

 

 

5.3 VibroSmart devices 

5.3.1 Module firmware 

There are no firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 6.0.0. 

 

The latest firmware for the VSI010 module remains: 

• 642-002-000-012.xmsifw. 

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-011.redboxfw. 

 

The latest firmware for the VSV30x module remains: 

• 642-001-000-000DEV_SVN14937_2020-05-20.xtranfw. 

 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are not required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 
hardware (XMx16 cards and VibroSmart modules and devices) before starting a 
VibroSight system upgrade, in order to establish if any firmware updates are also 
required. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. See 6.2.3 Updating the 
firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and VibroSmart 
devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to take advantage of 
improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used unintentionally or 
incorrectly, lead to malfunctioning of the device and affect proper function of data acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal machinery 
monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how 
they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and 
the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the VibroSight software 
installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their .tgz file name 
extension. For example, the XMV16 subfolder contains the applications and base system firmware for use by 
XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored in these 
directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 card hardware (that is, 
MPC4Mk2 firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 3 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 
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Table 4 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 
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Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

 VM600Mk2 MPC4Mk2 firmware  See note 1 

VibroSight software version 

CD part number 

Operational (640-025-vvv-ppp.Mpc4g2Fw) 

640-025-001-000 640-025-002-000 640-025-003-002 

Recovery (640-031-vvv-ppp.Mpc4g2Fw) 

--- --- 640-031-003-002 

Proof test (640-032-vvv-ppp.VxeFw) 

--- --- 640-032-001-000 

5.0.0 
609-004-000-048 

 See note 1   

5.1.0 
609-004-000-049 

  See note 2  

6.0.0 
609-004-000-050 

   See note 3 

 

Notes for Table 1 
1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is a release intended to support the development 
and evaluation of VibroSight Protect and VM600Mk2 systems only. 

 

2. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is a release intended to support the ongoing 
development and evaluation of VibroSight Protect and VM600Mk2 systems only. A firmware upgrade is required in order to run VibroSight 5.1.0 
or later. 

 

3. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – and in order to use the 
system in “live” machinery protection system (MPS) applications. Contact Meggitt SA for further information. 
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Table 2: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 640-014-001-002 640-014-001-003 

Applications (*.tgz) 

640-015-001-001 640-015-001-002 640-015-001-003 

3.4.0 
609-004-000-041 

 See note 2  See note 3  

3.5.0 
609-004-000-042 

   

3.6.0 
609-004-000-043 

   

3.7.0 
609-004-000-044 

   

3.8.0 
609-004-000-045 

   

4.0.0 
609-004-000-046 

   

4.1.0 
609-004-000-047 

   See note 4 

5.0.0 
609-004-000-048 

   

5.1.0 
609-004-000-049 

   

6.0.0 
609-004-000-050 

   

 

Notes for Table 2 (see the next page)  
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Notes for Table 2 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 

 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 

 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
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Table 3: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-011-001-004 640-011-001-005 

Applications (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

 

Notes for Table 3 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-VVV)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 

 

3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 4: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

CD part number 

Base-system (*.tgz) 

640-003- 
001-016 

Applications (*.tgz) 

640-010- 
001-016 

3.4.0 
609-004-000-041 

 See note 2 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

 

Notes for Table 4 (see the next page)  
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Notes for Table 4 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw file 
name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 6 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 7 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 5: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight software version 
CD part number 

642-002-000-009 642-002-000-010 642-002-000-011 642-002-000-012 

3.1.0 
609-004-000-038 

 See note 2 
See notes 

2 and 3 
 

 

3.2.0 
609-004-000-039 

   
 

3.3.0 
609-004-000-040 

   
 

3.4.0 
609-004-000-041 

   
 

3.5.0 
609-004-000-042 

   
 

3.6.0 
609-004-000-043 

   
 

3.7.0 
609-004-000-044 

   
 

3.8.0 
609-004-000-045 

   
 

4.0.0 
609-004-000-046 

   
 

4.1.0 
609-004-000-047 

   
 

5.0.0 
609-004-000-048 

  
See notes 

2 and 4 

See notes 

2 and 5 

5.1.0 
609-004-000-049 

    

6.0.0 
609-004-000-050 

    

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 
2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 
3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 
 
4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. A firmware upgrade is required in order to run 
VibroSight 5.0.0 or later. 
 
5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
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Table 6: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
CD part number 

642-004-000-011 

3.1.0 
609-004-000-038 

 See note 2 

3.2.0 
609-004-000-039 

 

3.3.0 
609-004-000-040 

 

3.4.0 
609-004-000-041 

 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 

 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 7: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 
CD part number 

642-001-000-015 642-001-000-016 642-001-000-017 642-001-000-018 

642-001-000- 
000DEV_ 

SVN14937_ 
2020-05-20 

3.4.0 
609-004-000-041 

See notes 

2 and 3 

See notes 

2 and 4 

   

3.5.0 
609-004-000-042 

  
   

3.6.0 
609-004-000-043 

  
   

3.7.0 
609-004-000-044 

  
   

3.8.0 
609-004-000-045 

  
   

4.0.0 
609-004-000-046 

  
   

4.1.0 
609-004-000-047 

  
   

5.0.0 
609-004-000-048 

  
See notes 

2 and 5 

See notes 

2 and 6 

 

5.1.0 
609-004-000-049 

    
See notes 

2 and 7 

6.0.0 
609-004-000-050 

     

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for hydro air-gap monitoring. 
A firmware upgrade is required in order to run VibroSight 3.4.0 or later. 
 

4. This version of VibroSmart VSV30x firmware adds support for latched alarms. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.6.0 or later. 
 

5. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 
6. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

7. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later.  
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to incoherent system 
behaviour and affect the proper functioning of data acquisition in a system. It is only in systems where the firmware 
running on the XMx16 cards and VibroSmart devices already corresponds to the latest available version that no 
firmware update is required. Therefore, it is strongly recommended to verify the version of firmware running on the 
hardware before starting a VibroSight system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 
that can – if performed unintentionally – affect the proper functioning of data 
acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 
hardware only when it is necessary. For example, when the devices must be 
updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16 
card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your 
network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VibroSight-compatible VM600 card or VibroSmart device 
selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware (VM600 cards 
and /or VibroSmart modules) have been discovered and that data acquisition has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 

 

 

 

  



 

RELEASE NOTES 
VibroSight® 6.0.0 
64 / 67 

Document reference VIBROSIGHT-RN/E (660-010-013-231A) 
Version 31A – 04.03.2021 

 

7 Customer support 

7.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

7.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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Appendix 
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VibroSight software and Windows operating system compatibility 

 

 
Windows 10 Windows 8.1 Windows 7 

VibroSight software compatible? Yes Yes 

Yes 
(but not recommended for new 

installations as Microsoft support for 
Windows 7 ended in 

January 2020) 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 
Windows Server 2016 Windows Server 2012 Windows Server 2008 R2 

VibroSight software compatible? Yes Yes 

Yes 
(but not recommended for new 

installations as Microsoft support for 
Windows Server 2008 R2 ended in 

January 2020) 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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